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How to use this guide 

 
 

 Fix my document Format my document 

Identify the issue I have with 

my document 

I want to 

*We usually recommend creating 

and using templates: they save you 

time and ensure consistency with 

formatting.  Templates are 

especially useful for long documents 

such as PhD theses. 

To prevent damaging your actual 

document, you are recommended to 

practice these steps on a COPY of 

your work first. 

Identify the issue I have with 

my document 

Locate the issues in the Table 

of Contents 

Follow the step-by-step 

instructions 

Identify format topic, e.g. 

Heading Styles  

Locate topic in Table of 

Contents*  

Identify the issue I have with 

my document 

Locate the practice file here: 

Start | All Programs | LSE 

Services | IT Training | Course 

Files | Word 2010 Format an 

Academic Paper  
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Creating a template 
A template is a pre-formatted model on which other documents are created.  By default, Word 2010 

bases all documents on the Normal.dotx template.   

Note: .dotx signifies that it is a template rather than a document. 

Creating your own template helps you create consistently formatted documents by specifying the 

default margins and other page setup details, default text format, heading styles and other 

formatting such as line spacing.     

Templates such as those used to create internal memos, invoices or formal business letters often 

contain text and other content such as organisational logos.  A template to be used for academic 

papers, on the other hand, should be completely blank but contain all the formatting styles you will 

need.  In the next sections you’ll learn how to create one. 

To create a new template 

1. Click File |New   

2. Click Available Templates | My Templates 

3. Within the New dialog box, click ONCE on the Blank.dotx or Normal.dotx 1template.2 

4. Click in Create New  Template | OK 

 
 

The new blank template opens.  Notice the word ‘Template’ in the title bar. 

 
5. Click File | Save As.  Use the File name box to save the template with a relevant file name.    

                                                           

 
1
 Note that the “t” in “.dotx” indicates that the file is a template. 

2
 You may have more templates available so what you see may not match the image here. 
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NOTE:  Do not change the file location.  On LSE computers templates are saved to the 

Templates folder in the LSE setup folder on your H: space.  (Your H: space is listed with your 

LSE user name displayed.  The example below shows H: space for Chris Steele selected.) If 

you are creating your template on a computer that is not connected to the LSE network, 

make a note of the location of the file.  (Here, for example, the file is located on 

H:\LSEsetup\Templates.) 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: When attempting to save the template, a warning box with information about file 

formats and using new features in Word may appear. If so, click OK to continue and save the 

template. 
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Modifying a template 
After creating a template, you can then modify it. For example, you may wish to change the page 

setup including the margins. 

To modify the page layout of a template 

Open your template by right-clicking on it in the Templates folder and from the 
menu click on Open. 

Note: by default, templates are stored in a dedicated folder.  If you have 

followed the guidance above, you will have saved your template in 

H:\LSEsetup\Templates.  If you recently saved it elsewhere, open the File 

tab, select Recent and look for the template in your Recent Documents list. 

 

Margins 

For predefined margins:  with the template open, click Page Layout | 
Page Setup | Margins.  A list of pre-set margins is displayed.  Click on 
the one that suits your purposes.  If there is not a suitable one, you can 
create a custom margin. 

Custom Margin 

Click on Custom Margins… at the bottom of the list.  The Page Setup 
dialog box opens. 
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With the Page Setup dialog box displayed, on the Margins tab, enter the dimensions you 

require. 

 

Orientation 

Under the margin settings, you can set whether your 

document is to be landscape or portrait.  Make sure you 

know ahead of time which you will need.  Though you can 

always change this when creating a document, doing so will 

upset the flow of your work. 

Document Binding (Gutter) 

If you want to bind your document when it is finished, you 
should also enter a Gutter dimension and position (the 
gutter is usually positioned on the left-hand side of a 
document and allows enough space for the ring binding).   

The gutter is an area outside of the margins. 

 

As you increase the Gutter size, the preview will begin to display a hatched 

area representing the binding area you are creating.   

 

Headers and Footers 

To change the size of the header and footer, click Page 
Layout | Margins | Custom Margins | Layout  

Set the dimensions of the Header and Footer. 

When you have made all the necessary changes to the 
page setup, click OK. 

 

Save the file and keep it open. 
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Creating a new document based on a 
selected template 
In Word, all new documents are based upon the Normal.dotx template unless you select a different 

template.   

To create a document based upon a template other than the default 
Normal template 

1. Click File | New 

2. Under Available Templates click My templates 

3. Within the New dialog box, click ONCE on the template to be 
used and ensure the radio button adjacent to Document is 
selected before clicking OK. 

 

Note: if the template you wish to use is not displayed in the New dialog box, then it is not in 

the default templates folder on your computer. For more information, see note on page 6 

above. 

The new blank document is displayed. Notice the word ‘Document’ in the title bar. 

4. Save the document with an appropriate name in the location of your choice. 

Typing text using the styles in your template 

If you are writing your document from scratch, you can start adding text immediately.  As you type, 

every paragraph will be formatted in the style selected in the Styles list.  If you want to use a 

different style, select it before you begin typing. 

1. Before you begin typing, go to Home | Styles and select the style you require.  (The options 
shown here are in the Quick Styles Gallery.   Use the More arrow to display the entire list 
available there.) 
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2. By default, many styles are not displayed in the Styles group until they have been used for the 
first time.  If the style you require is not shown, click the Styles Pane launcher in the far bottom 
right corner of the Styles group to open the Styles pane.   

 

3. Click on a style to apply it.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. To change the style of text already in the 
document, click in the paragraph and click the 
style required. 

 

 

 

Note:  Sometimes you’ll find that you must click 

the style button twice to apply all elements of the style.  If that still doesn’t work, with the 

relevant text selected, click Clear All (at the top of the styles list) and then apply the style 

required. 

Note: 

 After you use a style for the first time, it generally appears in 

the Quick Styles Gallery on the Home tab, making it easier 

to find the next time you want to use it. 

 When you press enter after typing text using a Heading style, 

by default the next line automatically is formatted in Normal 

style.  (See the Style for following paragraph settings point 4 

on page 17.) 

 There are likely to be styles shown in the Quick Styles 

Gallery which you do not plan to use. To avoid confusion and 

mistakes, you can remove them from this list by right clicking 

on them and selecting Remove from Quick Style Gallery. 

This will not delete the style from your template. 

 If you cannot find a style in the list, scroll to the bottom and 

look for it there.  Styles are not in strict alphabetical order. 

 Tick the Show Preview box to display the style names in the 

style they represent. 
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Combining multiple documents into a single 
file 

Inserting document text and images using section breaks 

When drafting a major academic paper or book, it is easier to work in smaller documents so, rather 

than creating the paper as one large document, you may choose to create each chapter as a separate 

document. 

Once you have finished each chapter, you can then combine them all into one document, using 

section breaks to separate each chapter before creating a table of contents and any tables of figures, 

maps, tables or images you may require. 

To insert text from one document to another 

1. Click where you want to insert the text 
from another document. 

2. Click Insert | Text | Object | Text from 
File…  

3. Navigate to the document that holds 
the text. 

4. Select the document and click Insert. The entire contents of the file you have selected, 
including its original styles & formatting, are pasted into the new document. 

Section breaks 

By default, Word documents are created as a single section. This means that the page layout, 

headers and footers will be the same throughout the document. 

By using section breaks, you can split a document into several sections and apply different formatting 

and layouts to each. For example you can change the orientation of a single page from portrait to 

landscape for the purpose of displaying an image, table or chart. You can also use different page 

number formats such as Roman numbers (i, ii, iii) for the table of contents and abstract and Arabic 

numbers (1, 2, 3) within the body of your paper. 

There are four types of section break:  

 Next Page section breaks start a new page, and allow the user to change header and footer 
options (including page number formatting) and/or page layout options from that point 
forward. (A simple page break, by contrast, starts a new page within the same section of the 
document.) 

 Continuous section breaks are used primarily for displaying text in two or more columns. 

 Even Page and Odd Page section breaks start a new section on the next odd or even 
numbered page. If you want each new chapter to always start on an odd numbered page, 
this is for you! 
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To insert a Section Break 

1. Click in your document where you want to insert the Section Break 

2. Click Page Layout | Page Setup | Breaks 

3. Under Section Breaks, select the section break you need.  The cursor moves to the next 
appropriate page.  

 

Which section am I in? 

To identify which section of a Word document your cursor is in, look in the status bar at the bottom 

of the screen. 

 

 

 

Note: if Section isn’t displayed in the status bar, 

right click on a blank section of the bar to open the 

Customise Status Bar list and click on Section. 

Section appears on the bar, displaying the current 

section number. Click outside the list to close it.  

 



 

Fundamentals 
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Modifying & creating paragraph styles 
All new documents contain a variety of built-in styles.  Each style is relevant to a specific type of 
formatting: character, paragraph, linked, list and table formats.  When you start typing in a new 
document, the text is formatted in Normal style -- the built-in default style for text; you can create 
your own Normal style when you create your own template.  If you wish, you can modify what the 
Normal style is in your own template.  All styles based on the on the previous Normal style will 
update to reflect the change.  If in doubt, you can find out which style has been applied to selected 
text or will be used as you type (where the cursor is positioned) by finding the highlighted icon in the 
Styles group on the Home tab or in the Styles Pane. 

Viewing all styles available 

1. Click Home | Styles | Style Pane launcher The Styles pane 
opens.

 
2. Click on Options…. at the bottom of the Style Pane. 

 

3. With the Style Pane Options dialog box displayed, click on the 
drop-down arrow under Select styles to show and select All styles. 

 
4. Click OK to close the Style Pane Options dialog box.  The Style 

Pane now displays all styles available in the current document, 
including those in the template (both default and user-created) 
and any others applied to the current document.   

 

NOTE:  Clear All, at the top of the list, is the only item listed which is NOT a style.  Instead, it 

is a command which, when applied to selected text, changes all formatting to the default 

Normal style. 
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Modifying a style 

A style is pre-set in terms of font size, colour etc. but it can be modified.   

Note:  changes you make to a style are automatically applied to all text formatted in that style 

in your document.   

To modify a style 

1. With the Style Pane displayed, position your mouse pointer over (do not click) the style you want 
to modify. Note: This list is not in strict alphabetical order. 

2. Click on the drop-down arrow that appears to the right of the style name and click Modify from 
the list of options. 

 

3. With the Modify Style dialog box displayed, examine the settings and make any changes 
required.  A number of standard formatting options, such as bold, font size and type, and 
paragraph alignment, are immediately available within the dialog box. 

 

TIP: use the formatting 

options circled here to 

adjust line spacing to any of 

three standard options. 
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4. For more formatting options, including additional paragraph and font commands, click the 
Format button at the bottom of the dialog box.  Click the option required to open the dialog box 
needed, change the relevant settings, and click OK to return to the Modify Style dialog box. 

a. To set Spacing after each paragraph, select Paragraph, and adjust the setting on the 
Indents and Spacing tab.  (Setting this to 12, for example, will automatically add an extra 
blank line after each paragraph.)  Note: You do not need to press the return key twice 
between paragraphs. 

b. To set Indentation, select Paragraph, and adjust settings on the Indents and Spacing tab. 

5. To ensure that this style will be easily available in the Home tab Styles group, ensure that Add to 
Quick Style list is ticked. 

6. To save this modified style in the template, so that other documents based on the template also 
have it available, click New documents based on this template radio button. 

 

7. When you have finished making the changes needed, click OK to close the dialog box. 

8. Save your document.  A dialog box opens. 

 
9. Click Yes to save your style changes to the template. 

Creating a new paragraph style 

As well as modifying an existing pre-set style, it is also possible to create a new style:  

1. With the Styles dialog box displayed, click the New Style  button at the bottom of the Style Pane. 

 
2. With the Create New Style from 

Formatting dialog box displayed enter a 
name for the style.   

Note: Naming each style according to 

where/how it should be used will help 

you maintain formatting consistency 

later. 

3. Select a style type from the Style Type 
drop down list.  
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4. Select a style that you will base your new style on from the Style based on drop-down list; this is 
generally set to Normal. (If Normal style is updated later, the changes will be carried through to 
this style, too.) 

5. Select a style from the Style for following paragraph drop-down list; this is generally set to 
Normal. (When you press the return key to create a new paragraph, the style automatically 
changes back to Normal style for the following paragraph.) 

6. Set the formatting you require, using any options available from the Format button. 

Note:  To specify a font size that isn’t in the list, simply overtype the number. 

7. To ensure that this style will be shown in the Home tab Styles group tick Add to Quick Style list. 

8. To add this new style to the template associated with your document, click New documents 
based on this template. 

 
9. When you have finished, click OK to close the Create New Style from Formatting dialog box.  The 

new style appears within the Style Pane and in the Home tab Styles group. 

Formatting the title page 

Even though the formatting used on the title page is unlikely to be used elsewhere in the document, 

it is still best to create a style for each format used.   (Name each style appropriately so that you can 

easily remember how they are meant to be used.)   

NOTE: do NOT use your heading styles to format the title page, even if the format you 

require here is identical to one or more heading styles.  Any text formatted with a heading 

style will show up in both the table of contents and in the navigation pane. 
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Inserting page numbers 
Page numbers in a Word document are placed in either the header, or footer, or margins of each 

page. 

To insert page numbers 

1. Click anywhere in the document. 

2. Click Insert | Header & Footer | Page Number 

 A menu is displayed with various page number options 

 

3. Position the cursor over the position of interest to display a gallery with more page numbering 
options such as alignment and format. 

 
4. Click on the option of interest to insert the page number at that position.  In fact, you are 

inserting a field which updates as your document grows or shrinks. 
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The page numbers will be inserted on all pages in the document and the cursor will appear in the 
related header or footer of the current page.  As a result, the Header & Footer Tools contextual 
tab is displayed in the ribbon, allowing you to customise the Header and Footer. 
 

  
Note: to remove the page number from the first page of a document, tick the box alongside 

Different First Page in the Options group. 

 

 

You can leave the Header and Footers section by clicking the large red Close Header and Footer 

button.  Alternatively, double-click outside of the footer/header area 

 

 



© London School of Economics & Political Science 21 lse.ac.uk/IMT/training 

 

Footnotes and endnotes3 
Footnotes and endnotes are useful when you want to add additional information to your document, 

such as a reference, which you do not want to include in the main part of your text.  A number, or 

letter, is inserted into the text telling you which footnote or endnote is the relevant one.  Footnotes 

are placed at the bottom of the page on which the reference number appears, endnotes are 

gathered together and can be placed either at the end of the related chapter or at the end of the 

document. 

Inserting footnotes 

To insert a footnote 

1. Place the cursor within your main text where you want to apply the footnote. 

2. Click References |Footnotes | Insert Footnote. A number appears in the text and at the 
bottom of the page; your cursor is positioned next to the number at the bottom so that you 
can type the note as required. 

3. Type your note, then click back into the text in the main section of the document to continue 
your writing. 

Inserting endnotes 

To insert an endnote 

1. Place the cursor within your main text where you want to apply the endnote. 

2. Click References | Footnotes | Insert Endnote.   A number appears in the text and at the 

place where you want the endnotes to appear; your cursor is positioned next to the number 

so that you can type the note as required. 

3. Type your note then click back into the text in the main section of the document to continue 

your writing. 

Combining footnotes and endnotes in a document 

 Complex documents such as theses could very well contain a combination of footnotes and 

endnotes.  This is possible to do with Word.  You need to make sure you select the correct option 

from References | Footnotes  

 

 

                                                           

 
3
 Note: Endnote is the name of a product which manages bibliographic referencing.  It is supported by the 

School and help is available at IT Surgeries and training sessions.  More information here: 
http://www.lse.ac.uk/library/services/training/endnote/Endnote.aspx  

http://www.lse.ac.uk/library/services/training/endnote/Endnote.aspx
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Converting footnotes to endnotes 

If you decide to convert footnotes to endnotes (or vice versa) 

1. Click References | Footnotes and then click the dialogue box launcher 

 

 

2. Click Convert… 

3. In the Convert Notes dialouge box Choose the appropriate option for the change you wish to 

make 

 

 

Note: Ensure that you Apply changes to the correct part of your document: the current section you 

are in or the whole document. 

Placing endnotes 

If you wish to place your end notes at the end of each chapter, 

make sure the chapters are in their own sections.  You can also 

place the endnotes at the end of your document.   
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Creating & updating a table of contents 
A table of contents shows the order of the headings and sub-headings in the document along with 

their page numbers.  If you have applied heading styles to the headings in your document you can 

automatically create a table of contents.  If you edit the document subsequently, it takes just a 

couple of clicks to automatically update the table of contents. 

Creating a table of contents 

To automatically create a built-in table of contents 

Note: The following steps assume that you have used Heading Styles in your document. 

1. Position the cursor where you want to insert the table of contents.  You might have to create a 
new page between your title page and the main text.  

2. Click  References |Table of Contents | Table of Contents 

 
3. Click on one of the Built-in Automatic Tables and your Table of Contents will be inserted. 

 
The table of contents will be displayed.  

 

Note: navigate to any heading in the table of contents by holding down CTRL on the 

keyboard and clicking once on the relevant heading. 
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Updating a table of contents  

Once you have created the table of contents it will not update automatically if you edit content 

which then changes page numbers, or make changes to the headings - you must force it to update by 

following the steps below. 

To update a table of contents 

1. Click once on an entry within the table of contents and a blue border will appear with a 
contextual tab at the top-left of the table.  Also, the table’s fields will be highlighted in grey.  It is 
these fields which allow the updating to occur 

 
 

2. Click Update Table… on the contextual tab or press F9 
 

The Update Table of Contents dialog box is displayed. 

 
 

3. Choose Update page numbers only if the page numbers have changed as a result of editing or 
choose Update entire table if you have made any changes to headings or added new headings. 

4. Click OK 
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Using the Navigation Pane 
The navigation pane creates a navigable outline of any document formatted based on Heading styles, 

allowing you to easily move between the various sections.   You can also use the navigation pane to 

search for text, images, tables and equations. 

1. To display the Navigation Pane View | Show | Navigation Pane.  The Navigation Pane is 
displayed. 

2. Click on any heading to move to that section in your document. 

 

3. The headings are displayed as a hierarchy.  Collapse and 
expand levels by clicking the triangle to the left of a 
heading.  

 



 

© London School of Economics & Political Science 26 lse.ac.uk/IMT/training 

 

 

4. To jump between pages, click the Browse the pages 
in your document tab at the top of the Navigation 
Pane. 

 

 



 

Beyond basic text 
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Cross-referencing 
Cross-referencing allows you to refer to text within a document such as a caption assigned to a 

figure. The reference can be automatically updated if the relevant caption number or text is changed. 

Cross-references can be created for headings, bookmarks, tables, footnotes and more. 

To insert a cross reference to a figure 

1. Position the cursor where you 
want to insert the cross-
reference. 

2. Click References | Captions | 
Cross-reference.  The Cross-
reference dialog box is 
displayed. 

 

 

 

 

 

 

 

3. Click on the drop-down arrow below Reference type and select “Figure”.  A list of captions 
applied to figures within the document is displayed.   

4. Choose the reference type 
which is relevant to you. 

 

 

 

 

 

 

5. In the For which box, select the reference to be inserted. 

6. Click Insert to insert the cross-reference. 

7. Click Close to close the Cross-reference dialog box. 
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Insert Excel charts  
Inserting a chart from Excel should be fairly straight-forward. However, there are several ways in 

which things can go wrong. We’ll insert a chart and address the most frequently encountered 

problems: changing page orientation, updating the chart and fixing uneven time lines. 

To insert an Excel chart in a Word document 

1. Open the Excel file containing the chart you need.  

2. Click once on the chart and click Copy (or press Ctrl + C). 

3. Return to your draft paper in Word. 

4. Right-click on a blank line where you want the chart to appear and select Paste. The chart is 
pasted into the document. 

5. To change the size of the chart, move the mouse pointer onto one corner of the chart area 
without clicking. The pointer shape changes to a slanted double-headed arrow. 

6. Click and drag the border to the size required. (Use Undo and start again if it goes wrong.) If 
you want to maintain the ratio, drag towards/away from the diagonally opposite corner. 

Note: If you use page numbers in the footer, remove them from this page or they will be at 

the side when your document is bound. 

Changing page orientation 

Some charts are too wide and detailed to look good on a page in portrait orientation. The key to 

changing orientation for the chart page alone, leaving the text before and after in portrait, is to place 

it on its own page, with Next Page section breaks immediately before and after. 

To change page orientation for a section of a document 

1. Click at the end of the line above the chart and press Enter to create a new blank line.  

2. Insert a Next Page Section Break. (Hint: Go to the Page Layout tab and open the Breaks icon 
list.) The chart is moved onto a new page. 

3. Click in front of the first character on the line below the chart and press Enter to move to the 
next line. Insert a Next Page Section Break here, too. The chart is now on a page of its own. 

4. Click onto the page containing the chart and go to the Page Layout tab. 

5. Open the Orientation icon list and select Landscape. The chart page is changed to landscape, 
but the pages before and after it remain in portrait orientation. 

Note: by default, the orientation command is applied to the section of the document that 

the cursor is in.   All pages in the section will be affected by this change. 

To change the orientation from this point forward or 

for the whole document 

1. Click on the tiny icon to the right of the Page Setup label 
on the Page Layout tab to open the Page Setup dialog box.   

2. Click on the Margins tab, open the drop down list for the Apply to field and select the 
required option. 
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a.  

3. Click OK to close the dialog box.  Orientation is changed as directed. 

 

Centring the chart on the page 

To horizontally centre the chart on the page 

1. Select the chart by clicking on its outer border. 

2. On the Home tab, move to the Paragraph group and click the Centre icon.  The chart is 
centred on the page. 

 
 

Updating the chart 

If the data shown in the chart is likely to change before your paper is submitted, you can insert the 

chart now with a link to its related Excel file.   This will ensure that the chart in your paper is 

automatically up-to-date after you edit the Excel file. 

Note: the process outlined below creates an on-going link between your paper and the Excel file 

containing the chart data.  Before you begin, move the Excel file into the same folder as your 

draft paper.  To ensure that the link between them remains unbroken, you will have to keep 

them together in a single folder from now on. 
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To insert an Excel chart linked to the original file 

1. Copy and paste the chart as usual. The chart appears in your Word draft, with a Paste 
Options icon alongside.  

2. Open the Paste Options list and select either 
Use destination Theme & Link data or Keep 
Source Formatting & Link Data.  

 
Note: If your chart is linked to the Excel file containing the chart’s data, you can update that 

data directly from Word.   

To update an Excel chart to reflect changes to the underlying data 

1. Right-click in a blank part of the chart area and select Edit Data. The Excel file opens in edit 
mode, enabling you to make any changes needed. 

Fixing an Excel chart timeline  

If your chart displays data only for some of the years in the period you are studying, sometimes you’ll 

need to tweak it so that it shows the data on a realistic time line.  This means that, if you have gaps in 

the years in your data, your chart will show these gaps.  The trick is to set your line chart as a time-

scale. Here’s how:  

1. Open your chart in Excel. 

2. Click in the chart. The Chart Tools group of tabs appears at the top of the screen. 

3. In the Chart Tools tabs, go to the Format tab. 

4. In the Current Selection group at the left end of the ribbon, open the selection list and choose 
the axis you want to convert to a time-scale. 

5. Right click on the axis and select Format Axis.  

6. Using the Axis Options item at the top of the column on the left of the window, select Date axis 
(about midway down the dialogue box). 

7. Click Close. The missing time intervals should now appear along the axis. 
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Inserting photographs 

To insert a photograph 

1. Click where you want to insert the image. 

2. Click Insert | Illustrations | Picture.  

3. Navigate to the image. 

4. Click on the image and then click Insert. 

5. If you want a border around the picture, click Format | Picture Border 
and make your border choices 

Resizing photographs 

1. Right-click on the photograph and select Size and Position. The 
Layout dialog box appears. 

2. If needed, click 
on the Size tab to 
activate it.  

3. Ensure that both 
boxes in the 
Scale section 
(near the bottom 
of the box) are 
ticked. (These 
prevent 
distortion of the image as you resize it.) 

4. Change either the Height or Width to the size required and press Enter. The picture is 
resized. 

5. The image may jump to another position in the text. Click and drag it to where you want it to 
be. 

Note:  The method suggested above prevents the picture from becoming distorted as it is 

resized, so is safer than selecting the picture and resizing it manually.  

Wrapping text around images 

1. Right-click on the image and select Wrap Text. 

2. Without clicking, let your mouse pointer rest on 
each option in turn to preview the effects 
available.  You will need text with your picture to 
see this work. 

3. To make text flow around the picture, click 
Square. 

4. Click and drag the picture until you achieve the desired result. 
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Creating numbered captions 
Any objects, such as charts, photos, maps, tables or equations, in your paper, should be labelled.  If 

you turn those labels into captions, Word will automatically number them and enable you to create 

an automated table of them (Table of Charts, Table of Maps, etc.) just as you created a Table of 

Contents at the beginning of your draft.  If you add, move or delete a caption, the other caption 

numbers will automatically be updated throughout your document. 

You can use or create different labels for the various objects i.e. table or equation, but the figure 

label can be applied to all. 

To create a caption below an object 

1. Select the object you want to add a caption to. 

2. Click References | Captions | Insert Caption.  The 
Captions dialog box is displayed. 

3. Click the arrow next to the Label box to open the 
list to display the label options available.   

 

 

 

4. You can click to change ‘Figure’ to another option listed here.  Alternately, click the New Label 
button and type in the label of your choice.  Press Enter (or click OK) to close the New Label 
dialog box.  The blue label in the Caption box changes to match the label you have selected or 
created. 

5. In the Caption box, click after the label and number displayed, type a space followed by the 
caption text required for the object you have selected.  The blue label provides a preview of what 
your caption will look like, as shown in the example 
below. 

6. Click OK to close the Caption dialog box.  Your 
caption appears below the figure. 
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Adding chapter numbers to captions 

To add chapter numbers to captions, you must have first created a numbered list style for your 

chapter headings in order for this to work.  See companion guide Creating Numbered Headings for 

directions on how to do this. 

If you have used a numbered list style for your headings, follow these steps to add numbers to your 
captions: 

1. Click into your document at the point where you want your caption to appear. 

2. Click References |Insert Caption. 

3. Select or create your label. 

4. Click Numbering |Include chapter number.  

5. Ensure that the Chapter starts with style box is set to the heading level you use for chapter 
names. Then click OK and OK again.  A caption appears including the chapter as part of the item 
number. 
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Creating a table of figures 
In the same way that you can create table of contents based on the heading styles in a document, 

you can create a table of figures based upon the captions assigned to objects. 

To automatically create a table of figures 

1. Click where you want insert a table of 
figures and type an appropriate title 
e.g. Table of figures. 

2. Clck below the title. 

3. Click References | Captions |Insert 
Table of Figures. 

The Table of Figures dialog box is 
displayed. 

4. Click OK as no format changes are 
necessary. 

 

Note: Though the tab is called Table 

of Figures, all captions can be found 

here on the Caption label drop down 

list. 

 

Note: it is possible to navigate to the figures displayed in the table by holding down CTRL on 

the keyboard and clicking once on the relevant link. 

Updating a table of figures  

Once you have created the table of figures it will not update automatically when you edit labels or 

add/remove objects - you must force it to update by following the steps below. 

To update a table of figures 

1. Click once within the table of figures and a grey background will be displayed on each entry. 

 

2. Click References | Captions | Update Table 
or press F9 on the keyboard. 
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Advanced document navigation 

Finding tables, equations, charts & photos, footnotes & endnotes  

In Word 2010, the Find and Replace commands operate from the Navigation Pane. If the Pane isn’t 

already open, Ctrl+F will display it. 

1. To find charts, photos or any other 
non-text content, click on the drop-
down arrow to the right of the Search 
Document text box and select the 
type of object you are searching for 
such as a table or a graphic.  The 
cursor moves to the first instance of 
the object you selected.  In the 
navigation bar, just under the Find 
box, a message appears saying how 
many matches have been found.  
Amongst the headings in the 
Navigation bar, each heading that 
contains a match is highlighted, and 
the one currently displayed is darker in colour.   

Note:  Use the Graphics option to find and navigate between photographs, 

charts, clip art and other images. 

2. To move forward and backward between the objects selected, use the 
Previous search result and Next search result arrows. 

Note: To find specific text, click the relevant tab at the top of the Navigation 

Pane and enter the text within the Search Document text box. 

 

Moving through your document by heading or section 

The Browse section of the vertical scrollbar provides additional ways of moving through your 

document. 

To browse by section, heading or other object 

1. Click on the grey Browse Object button, it has a circle, near the 
bottom of the vertical toolbar.  A menu opens providing a choice of 

10 different ways to move through your document.  Rest your mouse 
pointer on any option in the list to see what it represents at the top of 
the box. 

2. Click on an option to activate it.  The double arrows above and below 
the circle in the scrollbar turn blue. 

3. Click on the blue arrows to move through your document, 
viewing each of the objects you’ve selected.  



 

Troubleshooting 
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Maintaining format consistency 

Viewing styles in use 

The Styles list is your best friend when it comes to ensuring that formatting remains consistent 

throughout your document.  To identify inconsistencies, you need to view all styles in use. 

1. To open the Styles pane click Home |Styles | 
Styles Pane Launcher.  

2. Click on Options… at the bottom of the Style 
Pane. 

3. With the Style Pane Options dialog box displayed, 
click on the drop-down arrow under Select styles 
to show and select In use. 

 

How your style list grows automatically 

Whenever you use a new combination of font or paragraph commands to alter the format of text, 

Word automatically creates a new style based on your selection and adds it to the document’s styles 

list. Similarly, if you copy and paste text from another file which is formatted differently from text 

already in the destination document, each ‘new’ combination of formatting commands is added to 

the document’s style list. Thus, you could end up with a huge style list. 

For example, the screen shot below shows a single paragraph document and its list of Styles In Use. 

The paragraph was typed into a new document using Normal style (here set to Calibri font size 11). 

However, the font, bold and italic icons were used to make ‘selection’ stand out from the rest of the 

text. The Styles In Use list shows both Normal style and the new style applied to this word. (Unless 

you create a named style, Word will automatically name it by the attributes you have applied.) 

 

 

 

 

 

 

 

 

 

 

 

 

This can be confusing, but provides a method of identifying, selecting and correcting formatting 

inconsistencies.  In this section we focus on preventing the inconsistencies which such automatically 

generated ‘styles’ usually indicate. Then we will look at correcting problems in a document where 

styles were not used from the outset. 
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Maintaining format consistency 

Inconsistent formatting, and the redundant styles it creates, can be avoided by following these three 

essential rules:  

 Always choose the appropriate style before typing new text, headings, etc. If you use the 
wrong style by mistake, select the text and click the style you need to apply it.  

 Avoid bringing additional styles into the document when you copy or cut and paste from 
other files.  See Managing styles as you cut and paste from other files below. 

 Avoid using the formatting commands on the Home tab, that is, the buttons in the Font and 
Paragraph groups.   If you want to change the way some text looks, create or modify a style, 
taking care to update your template, too, as discussed below. Then apply the new/modified 
style. 

Managing styles as you cut and paste from other files 

When you copy and paste text from other documents, check the format of the selection first.  If it is 

different than the styles used in the destination document: 

1. Open both documents you wish to work with (source and destination). 

2. Copy or cut the text you wish to paste. 

3. Open the styles list to view Styles in use. 

4. Position the pointer in the destination document and ensure that 
the appropriate style is selected. 

5. Paste the text. Near the bottom right corner of the pasted text, 

the Paste Options icon appears.  

6. Click the arrow to display the Paste Options4 available and rest 
your mouse pointer, without clicking, on each of the four 
options to preview their effect on the format of the pasted 
material. Click on the option that will require fewest changes. 
(This will depend upon the style active at the cursor’s location and how the selection was 
formatted originally.) 

7. If needed, use the styles icons on the Home tab to change the format of the pasted text as 
needed. 

Keeping the styles in your template up to date 

You may decide to alter the format of some text as you work. Remember: avoid using the Font and 

Paragraph buttons as you work.  If you decide to change the format of some text, modify an existing 

style or create a new one, update the template accordingly, and then apply that style. This will 

ensure that this and all future documents based on the template will retain formatting consistency. 

There are two ways to modify a style (directly, by example) in both your document and the template 

used to create it. If you know exactly how you want to change the style, modify the style directly as 

                                                           

 
4
 For more on Paste Options, see http://office.microsoft.com/en-us/word-help/paste-options-

HA101831692.aspx  

http://office.microsoft.com/en-us/word-help/paste-options-HA101831692.aspx
http://office.microsoft.com/en-us/word-help/paste-options-HA101831692.aspx
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detailed in the first instruction below. You may need to play with the formatting of a bit of text 

before you decide exactly what formatting you prefer, use the second method. 

To modify a style directly 

1. Close any other documents, such as other chapters, which are based upon the same 
template. (You cannot update the template if other documents which use it are open.) 

2. Right-click on the style you want to change in either the Home tab’s Styles group or the 
Styles pane, and select Modify...  The Modify Style box opens.  

3. Near the bottom of the box, click New documents based on this template to ensure that the 
changes you make to the style in this document also are made in the template.  

4. Make the changes required. 

5. Click OK 

6. Save the document. A dialog box 
opens asking whether you want to 
save changes to the template. 

7. Click Yes. Your template has been 
updated for all new documents based 
on this template. 

NOTE: this will NOT update the template used in already existing documents, such as 

other chapters you may already have written.  
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To modify a style by example 

1. Close all other documents, such as other chapters, which are based upon the same template. 
(You cannot update the template if other documents which use it are open.) 

2. Select some text that will be formatted in the modified style.  (If you want to change a 
character style, select a character or word. If you want to change a paragraph or linked style, 
be sure to select an entire paragraph.) 

3. Make the formatting changes required by using the icons in the Font and/or Paragraph 
groups on the Home tab. 

4. Right-click on the style to be modified in the Styles group on the Home page and select 
Update [style name] to Match Selection. All text formatted in that style in the current 
document is updated. 

5. Right-click again on the style you have just modified and select Modify... The Modify Style 
dialog box opens. 

6. Click New documents based on this template. 

7. Click OK 

8. Save the document. A dialog 
box opens asking whether you 
want to save changes to the 
template. 

9. Click Yes. Your template has 
been updated for all new 
documents based on this 
template.  

 

NOTE: this will NOT update the template used in already existing documents, such as 

other chapters you may already have written.  
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Clean Up Method 1 - Clear All! 
At times, it will be necessary to remove excessive or redundant styles from your document so that, 

what you are left with, is a lean collection of styles which are in use. 

This method is ideal for a document where there are too many formatting problems to count!  In 

such cases, it is often best to reformat the entire document on Normal style and then apply other 

styles as needed, working systematically through the document. 

Note: if your document contains tables, charts and other content with special formats, it may be 

easier to use this method on one section of your document at a time, avoiding the specially 

formatted elements so that you do not inadvertently remove formats you want to keep. 

1. Save your file with a new name so the original can be used as a comparison and backup copy.  

Note: It’s a good idea to make a back-up copy of your draft after each key step.  That way, if 

something goes wrong, you won’t have too many steps to retrace. 

2. Select the entire contents of your document by clicking anywhere in the text and pressing        
Ctrl + A on the keyboard.  

3. Click Home | Styles | Style Pane Launcher.  

4. From the top of the list, click Clear All. The format of the entire document is changed to 
Normal style. Hyperlinks, footnotes, charts, etc. are formatted distinctively. 

5. Open the Styles list to view styles in the current document.  

6. Starting at the beginning of the document, find each chapter heading and change the format 
to Heading 1. 

 

7. When all the chapter headings have been formatted correctly, return to the first page and 
systematically apply Heading 2 style everywhere required through the document.  Then 
repeat the process for all other headings and then each of the other styles required.  This 
includes: quotes, body text etc. 

8. Save AllChapters-NewFormat.docx. 

Note: So that you don’t miss anything that needs reformatting, you may find it helpful to open 

each of the original files in turn, comparing them side-by-side with your latest draft to help you 

find all other text that requires application of a different style.  To do this, click  

View | Window | View Side by Side 
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Clean Up Method 2 - Using the Styles list to 
find & correct inconsistencies 
Whenever you use individual formatting commands, Word automatically identifies the combination 

of commands applied to the text you have selected and either creates a new style based on those 

commands, or adds the selection to the list of other instances where the same formatting commands 

are in use.  A long list of such styles can be confusing, and usually indicates problems in formatting 

consistency.  However, this feature can be used to rapidly correct formatting problems.  

In the lengthy course of producing a major paper, such inconsistencies have a habit of creeping in, 

even if you started out with a well-designed template, or applied Method 1.  However, as long as you 

have adhered to the guidance on maintaining consistency, these shouldn’t be too onerous to fix 

individually. 

Note: This method is good for cleaning up a relatively small number of inconsistencies. 

1. Open the style list and examine the list of styles in use. In addition to the styles you have 
created or modified in your template, there may be a number of other styles listed.  

2. Move to the top of the list, find the first ‘extra’ style listed and Select all instances. All text 
formatted in this style is selected throughout the document.  

 

 

3. Use the scroll bar to scan the selection to decide whether all can be reformatted using the 
same style. 

4. Hold down CTRL and click to deselect any anomalies; then apply the appropriate style to the 
rest. Repeat this step until the ‘extra’ style no longer appears in the list. 

5. Repeat steps 2-4 until the first ‘extra’ style disappears from the list. 

6. Move to the next ‘extra’ style, and repeat steps 2-5. Continue this process until only the 
styles you created or modified in your template are left in the list. 
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Method 1 or Method 2: which should I use? 

Both methods have their advantages and disadvantages.  If you have lots of formatting issues to 

correct, but also have sections containing intricately formatted tables or other content, it may be 

wise to apply Method 1 to selected sections of your document, one by one, rather than clearing all 

formatting from the entire document. 

Method 2 can be very useful but protect yourself from unpleasant surprises: scroll through to find 

each instance of a style’s use before you modify it or apply a different style to all selected.   

The biggest problem with applying Method 2 comes when you’ve inadvertently created many 

dependent styles.  (These are styles based upon styles that are themselves based on other styles!  

This happens all too easily, without you realising it, when you use formatting icons - Font and 

Paragraph images below - rather than applying styles you have created in the Styles list.) The Styles 

list shown here is the result of many people working together on a long document.  One person 

created and used a few styles; Style A was used to do most of the drafting, but various individuals 

later saw fit to apply additional formatting commands.  The end result was a formatting nightmare!  

In cases like this, Method 1 is almost certainly going to be the most efficient way to bring some order 

to the document’s format.  

 

Don’t be afraid to experiment with each method.  

Remember: Word provides an Undo icon for a 

reason!!  Also remember create a backup of your 

work as you go along, just in case 
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Using Show/Hide to correct problems 
Styles are the answer to most – but not all – formatting problems. When something in Word just 

doesn’t look right or doesn’t work in the way you expect, the Show/Hide button is often 

key to identifying the nature of the problem. Click Home | Paragraph | Show/Hide   

Show/Hide is a kind of on/off switch used to display hidden formatting commands5. 

Each command has its own symbol.  In most cases, to delete the command simply delete the 

symbol. 

Symbol Command Example 

. 

(dot) 

Space 

(inserted using the space bar) 
 

 Tab 

(inserted using the tab key) 
 

 Paragraph  

(inserted by pressing Enter) 

(Note: this mark also stores the 

formatting commands for the 

paragraph) 

 

 Line break 

(inserted using Shift+Enter) 

(Note: this starts a new line in 

the same paragraph, and is 

especially useful in numbered 

lists.) 

 

 Anchor 

(indicates that the related 

image, chart, etc. will move 

with the text it is ‘anchored’ to) 

 

Turning on Show/Hide also displays any user-input page or section breaks. (See examples below.)  To 

delete one of these, triple click on it to select it. Then press Delete on the keyboard. 

                                                           

 
5
 For help with other command symbols, see http://word.mvps.org/faqs/formatting/NonPrintChars.htm.  

http://word.mvps.org/faqs/formatting/NonPrintChars.htm
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Trouble-shooting footnotes 

Preventing footnotes from splitting across pages 

To keep lines of each footnote together at the bottom of a single page 

1. Click anywhere in a footnote in your document. 

2. Open the Styles list to 
display Styles in use.  

3. If necessary, scroll through 
the list to find the style 
applied to this footnote. 

4. Rest your mouse pointer on 
the name of this style and 
click the options arrow on 
the right. Click Modify. 

5. From the Modify Style 
dialog box click Format |Paragraph.  

6. Select the Line and Page Breaks tab and ensure Keep with next and Keep lines together are 
selected. Click OK and click OK again. 

 

 

 

 

 

 

 


